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Oleh ; M. AI’ Amin



Dengan berkat rahmat Allah S.W.T, akhirnya modul Pelatihan Belajar
Multimedia & Animasi 3 Dimensi terselesaikan dengan waktu kurang lebih 2 minggu,
besar harapan Kami semoga dapat bermanfaat bagi yang berkenan membaca dan dapat
membantu dalam tutorial bagi yang sedang membutuhkan, untuk itu saran dan masukan
yang positif sangat kami harapkan demi lancar dan suksesnya dalam pembuatan modul
modul berikutnya, modul ini sudah pernah dipakai dalam tutorial untuk UKM(Usaha
Kecil Menengah), Mahasiswa Teknik Informatika Fakultas Teknologi Universitas
Trisakti dalam pelatihan Multimedia untuk Presentasi.

Saran dan masukan silahkan di layangkan di amin@trisakti.ac.id  atau

mohamin2070@yahoo.com  demikian selamat membaca , mencoba, semoga

bermanfaat.terimaksih.
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Membuat bidang kerja Vidio CD PAL
1. Panggil Adobe After effects
2. Pada tampilan awal kita mempunyai bidang kerja / project dengan nama untitled
project.aep (aep=after effects project). Namun project tersebut belum mempunyai
adegan / Composition dimana kita akan mengolah animasi. Untuk itu kita perlu
membuat Adegan / Composition baru dengan klik menu Composition > New
Composition. Akan tampil kotak dialog Composition setting. Agar animasi Kita
sesuai dengan standard Video CD PAL, atur
e Lebar layar / witdh = 352 Pixel
e Tinggi layar / height = 288 Pixel
e Frame rate = 25 frames per second (gambar per detik)
e Simpan hasil setting tersebut dengan nama missal VideoCD
e Untuk memanggil setingan tersebut, Anda tinggal memanggil preset
VideoCD
3. Untuk proyek ini kita hanya membuat animasi :
e Lama / durasi animasi 10 detik, atur: Duration 0:00:10:00 artinya 0 jam, O
menit, 10 detik, O frame ( 1 detik = 25 frame )
e KiIik tombol Ok

4. Maka tampilan bidang kerja sekarang sebagai berikuti:

Cornposition Marme: |Cnmp 1
Basic "\ Advanced
Width: |352
Height [558 [ Lock dspect Ratia ta 11:3 Pleasze name this preset:
Pixel Aspect Ratio | Square Pixels ;l Frame Aspect Rati I'\-"ileDCD|
11:9
Frame Rate: |25 Frames per secon d
Ok I Cancel

Resolution: | Full = | 352 %288, 396 KB per Bbpc frame

Start Timecode: |D,DD,DD,DD Base 25
Duration: ID,DD:WD:DD is 0:00:10:00 Base 25

Cance

Gambar 1, Composition Setting & Chose Name
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Mengimpor gambar

After Effects adalah software animasi bukan image editor, oleh karena itu image harus
disiapkan dahulu. Format Image yang dapat di import antara lain : Jpg, bmp, tga, dan psd.
Pada latihan pertama ini kita gunakan file impor dari Photo Shop.

1. Mengimpor gambar, klik menu file = Import = File...... ?

Lok in: [ 55 abr Bl G e

bar
{2 gbr _madul

il

59 lingkar
2] lingkar
i_‘j m3
% mi0
(2 ik
28 mm

Open I
Cancel

File rame: [

(KN EN

Files of type [ acceptable Fies

Format;

Import As: IFDutaga ¥

™ Sequence not available

™| Force alphabetical order

Import Fofdsr

Gambar 2. Impor File

2. Kilik file mm.psd, klik tombol open
3. Karena file mm.psd mempunyai 3 layer maka anda akan diminta memilih layer,

untuk itu pilih seperti gambar dibawah ini
.

Impart Kind: | Compasition -]

[Layer Cptians

% [verged Layers

€ Chooselayer: | MickyMouse PergiKer ja -]
Footage Dimensions: | Document Size -
O I Cance| |

Gambar 3. Import Kind
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4. Ulangi Impor file berikutnya

5. Sampai semua projek ada pada projek, seperti terlihat pada gambar dibawah ini

Gambar 4. Lembar Projek

Mengkomposisi Gambar
Data yang sudah masuk ke lembar project, masih belum tampil di layer, agar bias tampil
di layer maka data harus dimasukkan ke dalam Timeline Composition atau dapat

langsung ke layer.

Gambar 5, Background
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2. Ulangi untuk layer berikut / mm.psd dan layer berikut sehingga pada Timeline
terdapat 4 layer

Gambar 6, Empat Layer

3. Layer ke tiga dengan gambar mk.psd, Baru tampil di detik ke 4 ( 04:00f ). Geser

layer dan aktifkan dulu Selection Tool

Gambar 7, Selection Tools

4. Pada Timeline, geser bar berwarna merah pada layer mk.psd ke detik 4 ( 04:00f ),

seperti gambar dibawah ini

Gambar 8, Bar Warna Merah

5. Agar bisa melihat hasilnya tekan tombol Play / Pause pada palette Time Control,
dan akan lebih baik lagi jika menggunakan tombol Ram Preview.

Gambar 9, Time Control
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6. Hasil akhir : Current time indicator bergerak dan gambar MickyMouse Muncul
tiba — tiba di detik 04:00f

Current Time Indicakor

Gambar 10, Curent Time Indicator 4

Pembuatan Animasi

Animasi Objek Bergeser .
1. KIlik Tool Selection , klik layer 3 untuk mengaktifkan layer dengan gambar
lingkaran dengan tulisan MickyMouse Berangkat Kerja
2. Pada Timeline, pastikan Current Time Indicator berada di awal animasi ( 00:00f )

pada Palette Time Control, klik tombol First Frame

Gambar 11 Time Control

3. Pada Timeline, klik panah segitiga putih pada layer 3 maka muncul Transform,

klik segitiga putih pada Transform, maka akan muncul parameter position

Gambar 12 Klik Position
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4. Untuk memulai animasi posisi, klik tombol Time Vary Stop Watch di samping

Position

Gambar 13, Time Vary stop Watch

5. KIlik Tool selection, geser lingkaran ke posisi seperti gambar di bawah ini

I % [Composiion: comp & v = |

Gambar 14 Lingkaran Geser ke Bawah

6. Pada Timeline, geser Curent Time Indicator ke detik 2 ( 02:00f )

Current Time Indicator

Gambar 15 Curent Time Indicator 2
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7. Klik Tools Selection, geser gambar Lingkaran seperti posisi di bawah ini

Gambar 16, Lingkaran Geser ke Atas
8. Pada TimeLine, geser Current Time Indicator ke detik 4 ( 04:00f )

Current Time Indicator

Gambar 17, Curent Time Indicator detik empat

9. KIlik Tool Selection, geser gambar Lingkaran seperti posisi di bawah ini

Gambar 18, Objek Berada di Tengah
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10. Pada Timeline sekarang sudah ada empat buah keyframe untuk position :

Gambar 19 tiga layer

11. Sekarang tinggal melihat hasilnya, dengan cara tekan tombol Play/Pause atau

RAM Preview animasi anda pada palette Time Control.

Gambar 20 Time Control

Animasi Objek Membesar dengan Scale

1. KIlik tool selection , klik layer lingkaran untuk mengaktifkan layer tersebut
2. Pastikan saat ini Current time indicator berada di awal animasi (00:00f), pada

palette Time Control, klik tombol First frame

Gambar 21, Curent Time Indicator,First Frame
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3. Pada timeline, klik panah segitiga putih pada layer Lingkaran, lalu klik panah
segitiga putih pada Transform, maka akan muncul pengaturan keyframe untuk

scale, untuk memulai ukuran klik tombol Time Vary stop Watch di samping scale.

Trwsdng: Conpd - Timeline; Comp 2 x
0:00:00:00 (25,00 fps)

Gambar 22, Time Vary Stop Watch

4. Agar ukuran gambar tiga...... tetap, di layar Preview, Tahan dan Geser Titik
Control Kiri atas sambil menekan tombol Shift di keyboard. Geser sampai gambar

layer 3 berukuran kecil ( 36% dari ukuran aslinya )

@[ (100%) [ v £ (<3] 0:00:00:02 |2 ) @y Ful )3 | active Camera |

Gambar 23, Lingkaran Kecil

5. Padatimeline geser geser Current time indicator ke detik ke 4 ( 04:00f)

1
0z 02z i ks 08z 1
1 w 1

Time Ruler {Click ko set thumb)

Gambar 24, Curent Time Indicator detik 4
6. Pada layar Preview, ubah ukuran gambar layer 3 dengan cara merubah nilai scale

pada Timeline. Klik angka menjadi 100% ( gambar kembali ke ukuran asli ),

otomatis angka di sebelahnya ikut berubah menjadi 100%, karena tanda link /
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rantai sedang aktif. Maka kini pada Timeline Composition 1, sekarang sudah

mempunyai 2 buah keyfreme untuk scala :

Gambar 25, kembali ke Ukuran Aslinya 100%

7. Play / RAM Preview animasi anda, tampak animasi gambar lingkaran / Layer 3

bergerak berubahtempat sambil membesar.

Gambar26, Play/Pause

Animasi objek berputar dengan Rotation

1. Masih tetap bekerja pada layer 3
2. Pada Time, pastikan Current time indicator di 00:00f, pada palette Time Control,

Klik tombol First Frame

Gambar 27, Curent Time Indicator,First Frame
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3. Untuk memulai animasi Rotation, klik tombol Time Vary Stop Watch

Gambar 28, Time Vary Stop Watch

4. Kilik Rotation Tool untuk memutar gambar

"
Gambar 29, Rotation Tool

5. Pada layar Preview, Tahan dan Geser pada layer 3, maka gambar akan berputar.
Agar putaran bergeser setiap 45 derajat, tekan dan tahan tombol Shift di
Keyboard. Drag sampai gambar layer 3 terbalik 180 derajat

Gambar 30, Lingkar 180 Derajat

6. Pada Timeline, geser Current time indicator ke detik 4 ( 04:00f)

Time Ruler {Click to set thumb)

Gambar 31, Curent Time Indicator Empat
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7. Pada layar Preview, ubah putaran layer 3, dengan menggunakan cara
merubahnilai rotation pada Timeline. Klik angka menjadi 2 x +0.0 ( gambar

berputar 2 x 360 derajat )

=7 TransForm

% Anchor Point
Il - [2] be Position

i il - @@ Seale
KR - [Z] be Rotation

- ) Opacity
o]

Gambar 32, Rotation

8. Hasil akhir tampilan sebagai berikut

Gambar 33, Hasil Akhir

9. Jalankan dengan Play / Ram Preview animasi anda, dan lihat hasilnya

Gambar 34, Play / Pause
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Animasi Objek Transparan Menjadi Tidak Transparan
1. Aktifkan layer 3
2. Pastikan Current time indicator di 04:00f

Gambar 35, Current Time Indicator

3. Pada Timeline, klik panah segitiga putih pada layer 3, lalu klik panah segitiga
putih pada Transform, maka akan muncul pengaturan keyframe untuk opacity

4. untuk memulai animasi Opacity, klik tombol Time Vary Stop Watch, ubah
nilainya menjadi 0 ( semula 100 ), maka di layar Preview gambar Lingkaran akan
hilang / transparan

Gambar 36, Opacity 0 %

5. Pada Timeline, geser waktu ke 05:00f, ubah nilai Opacity menjadi 100, maka
layer tersebut akan tampak kembali, sekarang anda sudah punya 2 keyframe untuk
Opacity:

[='a

Gambar 37, Opacity 100%
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6. Tampilan pada layar seperti dibawah ini

Gambar 38, Hasil Akhir

7. Jalankan dengan Play / Ram Preview animasi anda, dan sekarang anda bisa

menikmati hasilnya.

Animasi Scale untuk Layer MickyMouse

Untuk lebih lengkap, dapat di tambahkan animasi scale pada layer 3 sehingga dari

transparan berubah menjadi ukuran normal dan tidak transparan / jelas.

Aktifkan layer MickyMouse
Aktifkan Time Vary Stop Watch di samping parameter scale
Buat keyframe scale di 04:00f = 150% ( ukuran besar )

Buat keyframe scale di 05:00 = 100% ( ukuran normal )

Gambar39, Scale

Latihan dasar ini sudah selesai tinggal render menjadi Avi.
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Final & Render
Render Animasi ke Avi
Untuk menampilkan hasil dari karya anda pada computer lain, maka hasil kerja anda
harus dibuat ke file yang berextention Avi. Untuk mendapatkan file Avi maka harus
melakukan proses rendering, makin panjang durasi animasi maka makin kompleks layer
yang anda olah, dan semakin lama pula proses anda melakukan render;

1. Klik menu Composition - Make Movie, maka akan muncul kotak dialog untuk

menentukan folder hasil render

S File name: [Lathan]
Saveastype:  [Videa For Windows [~avi

(ERJIES
!

Current Render

Gambar 40, Output Movi & Render
2. Klik tombol render,proses render sedang berjalan sampai diakhiri dengan bunyi

kring, tanda proses render selesai.
3. Untuk melihat hasilnya jalankan file Avi yang baru anda buat.
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File Edit ‘iew Favorites Tools Help | 'ﬂ'
i sl e = .
@Eack \9 I__’[ ‘/_ Search [L Folders |
i| Address Ihﬁ Di\Datail_multimediatazs\M_aftereffects j Go
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5 Mero 6603 = | Microsoft word Document
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Now
Playing
Media
Guide
Copy from
&)
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Copy to CD
or Device

Premium
Services  ©
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Chooser
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Gambar 41, File Video

Animasi Bayangan Texs Berjalan
Yang pertama harus anda lakukan adalah
1. Impor gambar jpg atau psd
2. Layer solid
3. Effect: Linear Wipe, Drope, Drop Shadow,
4. Blending Mode: Add
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Persiapan
Membuat tempat kerja Video CD PAL
Buat adegan / Composition baru, klik menu Composition - New Composition, Preset

VideoCD durasi 4 detik ( 0:00:04:00)

Composition Marme: |\at_2|

Basic “(advanced
Preset: [ VideoCD = | @ |
Width: [352
I™ Lock aspect Ratio to 11:9
Height: |z38

Pixel Aspect Ratio: | Square Pixels

Frame Rate: |25 Frames per second

Resolution: | Full x| 352 x 288, 396 KB per Sbpc frame
Start Timecode: |0:00:00:00 | Basez2s
Duration: |0:00:04:00 is 0:00:04:00 Base 25

=] Frame Aspect Ratio:
13

Ol | Cancel

Gambar 42, Composition Setting

Impor Gambar
1. Klik menu File = Import - FileUsakti, Klik file sunrise.avi terus tahan tombol

Ctrl pada keyboard, klik tulisan Universitas Trisakti & Pioner Perguruan Tinggi

Swasta Indonesia , maka kedua file tersebut akan terpilih, klik tombol open

2l
Look in: I\_)gbrimdul [ G s
l‘ Elig Ets
(it [EJtrsn
My Fecent i [EL
Docereres (| P e
© (a2 [l
\Eilayer_1 [EJwindaw
Desidon W ITERSAES [E]window pes
Elib [Elwme
(E]0 [E]wshet
4 [t
iy Dictivents [T
xinc
ar B ag:
My Compter ?2;"
. L4 2]
-
IETET il name [“usakiiped” - Suniise 2" =] Open
Places
Fleoitpe:  [MlacosstatieFies  ¥] Carcel
Foimat:
Impost &z [Faotage -
= enir
-
2

Gambar 43,

Import File
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2. Karena file usakti.psd mempunyai layer maka anda akan diminta untuk memilih
layer, pilih saja dua layer tulisan yang akan di tampilkan—> Kklik ok

Import Kind: | Footage =
Layer Options

" Merged Layers

&+ Choose Layer: | Universitas Trisakti

[ Pioner Perguruan Tinggi Swasta 1

. X Background
Footage Dimensions: [oocdmen = |

Ok I Cancel |

Gambar 44, Choose Layer

3. Sekarang di project anda sudah ada objek

g lat g tion 0:00
ﬁ Pioner .:.wl\lasta,li ] Pi‘n:toshop 344 KB
.@_Sunrise.avi Mideof.ovie 1.0MB A 0;00;14;19

Gambar 45, Project
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Mengkomposisi Gambar
1. Drag Sunrise.avi, ke Timeline atau langsung ke layar Preview

2. Drag file usakti.psd ke Timeline atau langsung ke Layar Preview,lihat tampilan
gambar dibawah

Timelre: stz %

0:00:00:00  (z5:007p8) Els @ilo ool —
®U0D | 7|4 Sowceame -ﬂ#\‘ﬂﬁ‘tf&@ | Parerk

R | 5 Rj Pioner Perguruan Tinggi Swasta/  [on 24 B Gl v

- U 2 [ Universitas Trisakt)/usaktips. =/ @ (i !

® U3 ) sunnse.avi & B (one. 0| 1

Gambar 46, Timeline & Layer Preview

Membuat Animasi
Membuat Bayangan Drop Shadow
1. Pada Timeline, aktifkan Usakti.psd

2. Klik menu effect > Persepective - Drop Shadow,maka akan tampil kotak dialog
Effect Control, atur parameter seperti gambar dibawah:

| l-. %y | Effect Conbrols: Universitas Trisakbifusakbi.ps [»| = W

lat_Z * Universitas Trisakkifusakti.ps

=1 7| Drop Shadow Reset Aot

Anirnation Presets: | None [x] 4P
1) Shadow Color (]
[ 1) Opacity 96 %
w7 ) Direction Bx4lz00e
[+ ) Distance 1200
[» ) Softness 150
) Shadauw Crily [ shadow Ol

Gambar 47, Projeck Drop Shadow
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3. Hasil akhir bisa di lihat di gambar bawabh ini:

Gambar 48, Layer Preview

Animasi Objek Muncul dengan Linier Wipe
1. Pada TimeLine, aktifkan klik objek Usakti.psd
2. Menu Effect > Transition - Linear Wipe, maka akan tampil kotak dialog Effect

Control seperti gambar dibawah ini:

% ) Wipe Angle Dxazzn0s

=

[ = Feather

Gambar 49, Linear Weap

3. Di layar Preview objek masih diam belum ada gerakan apapun, untuk
menganimasikan efek Linear Wipe, pada Timeline, pastikan Current Time
Indicator berada di awal animasi ( 00:00f )

Gambar 50, First Frame & Linear Weap
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4. Pada Timeline, klik panah segitiga putih pada objek Trisakti.psd, klik effect, klik
Linear Wipe, sehingga tampil parameter pengaturan effect untuk Linear Wipe
yaitu Transition complete, Wipe Angle Feather. Parameter tersebut sama dengan
kotak dialog Effect Control, sehingga untuk sehingga untuk membuat animasi
efek. Anda dapat menggunakan TimeLine ataupun effect Control, dalam latihan

ini kita akan menggunakan Timeline untuk membuat animasi.

- [Z] b Transition Completion
- ) Wipe Angle

R i Nl r—

[+ Transfarm

Gambar 51, Timeline plus

5. Agar arah gerakan wipe dari Kiri ke kanan, atur nilai pada parameter wipe angle
menjadi 0 X-90

s Effects
7] [ Drop Shadow FReset
(= ipe 1

D Transform

Gambar 52, Timeline min
6. Kita akan menganimasikan parameter Transition Complete. Klik Time Vary stop
Watch di samping parameter Transition Complete. Ubah nilai menjadi 100, maka

di Preview tulisan Universitas Trisakti akan hilang
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7. Geser Current Time Indicator ke detik 3 ( 03:00f)

Gambar 53, Current Indicator

8. Ubah nilai Transition Complete. Menjadi 0 (nol), maka di layar Preview tulisan

Universitas ?Trisakti akan muncul kembali.

Gambar 54, Curent Indicator

9. Sekarang anda tinggal melihat hasil kerja dengan tekan tombol Play atau Pause

juga bisa dengan RAM Preview pada palette Time Control

Gambar 55, Play / Pause

10. Anda bisa membuat batas Linear wipe yang halus, ubah nilai Feather menjadi 20

Gambar 56, Feather 20
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11. Play / RAM Preview animasi anda.

Gambar 57, Preview
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Animasi Text PUSKOM USAKT]I

Materi
1. Type Tool dan animasi ( Scale, Position, Rotation, Range Selector dan Wiggler )
TimeLine
Motion Blur
Efek: Card Wipe
Efek: Ramp
Efek Bevel Alpha
Efek: Radial Shadow
Efek: Echo

N o a kDD

Membuat tempat kerja Video CD PAL
1. Buat adegan / Composition baru dengan menu Composition > New
Composition, sesuai standard VideoCD PAL, 352 x 288 Pixel, Frame Rate 25
Frames per second
2. Durasi / Duration = 8 detik (0:00:08:00)

Background
1. Buatlah Layer kosong, klik menu Layer = New -> Solid, klik tombol Make
Comp Size agar ukuran Layer solid sama seperti Composition:

Gambar 58, timeline

2. Untuk membuat background gradasi, aktifkan layer solid tersebut, klik menu
Effects > Generate > Ramp, atur parameter di Effects Control seperti gambar di
bawah
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Gambar 59, Project Ram & Preview

Teks “ PUSKOM USAKTI ”
Setelah anda membuat background sekarang saatnya membuat text
1. KIik tool text - klik Horizontal Type Tool, pada layer Preview, ketik “
PUSKOM USAKTI” dengan parameter seperti gambar dibawah

B
T -l
PUSKOM USAKTL

Gambar 60, Horizontal Type Tool

2. Agar text “ Usakti” berwarna biru, blok / drag teks “ Usakti tersebut lalu ganti

warna di kotak palet Character : Fill Color menjadi biru
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Arial Black ¥ |
R - rad

PUSKOM

Gambar 61, Teks dengan File Color

Agar punya kesan timbul, maka anda klik menu Effects - Perspective - Radial
Shadow seperti gambar dibawah

b~ 7] Radial Shadow

- ) Shadow Calor (] (==

b 7 Opacity 70.0%

- ) Light Source [#] 1250500
[ ) Projection Distance 5,2

[ ) Softness IE !

) Render

[ ) Color Influence 50,0%
0 [ Shadow Only
o ] Resize Laver "

Gambar 62, Teks dengan Radial Shadow

PUSKOM
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Animasi
Animasi Posisi Rotasi Scale Teks “ PUSKOM USAKTI”
1. Animasi teks bukanlah efek, tetapi merupakan parameter pada Timeline. Klik

panah segitiga pada layer teks tersebut, maka akan tampil parameter teks.

Gambar 63, Teks

2. Untuk memberikan animasi perubahan posisi, klik di panah Animate, muncul
menu pilih position

 Character Offset
Character Yalue

.| 4 adobe phtos... | )

Gambar 64, Animate Position

3. Maka akan muncul parameter Animatorl - Range Selectorl - Position

Gambar 65, Position
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4. Buat 2 keyframe pada parameter position tersebut
e Aktifkan Time Vary Stop Watch di samping Position
e Di 00:00f ( detik 0), Position = 100,100
e Di 07:00f ( detik 7), Position = 0,0 ( posisi normal )

s b Ranige Selector 1
) [ T . 545 © <
5 Trarstom hee

Gambar 66, Position 1 & 7

5. Jalankan hasil kerja anda dengan Play / RAM Preview

PUSKOM

-

Gambar 67, Hasil Preview

6. Sekarang kita tambahkan animasi text berputar / rotasi. Untuk memberikan

animasi rotasi, klik pada panah Add, muncul menu Property = Rotation

Anchor Point
Position

- All Transform Properties

Fill Color »
Stroke Color 3
Strake Width

Tracking
Line &nchaor
Line Spacing

Character Offset
Character Yalue

Blur

o Seleﬁt 3
ETETEEEE

Gambar 68, Property, Rotation
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7. Maka akan tampil parameter Animatorl - Range Selectorl - Rotation. Buat 2
keyframe pada parameter Rotation tersebut
e Aktifkan Time Vary Stop Watch di samping rotation
e Di 00:00f ( detik 0 ), Rotation =0 x 270
e Di07:00f (detik 7 ), Rotation 0 x O ( rotasi kembali normal )

®don| & # | soucebame |2 % ~2HO#@ |parent LM
) Source Texk
> Path Options
[» More Optians
Ll 7 Animator 1 Add: @
= [ Range Selector 1
o b 5 fe Position 1000, 100,0
5 e o

Lol

Gambar 69, Timeline Rotation

8. Hasilnya anda tinggal klik Play / RAM Preview hasilnya seperti gambar di bawah

Gambar 70, Hasil Rotasi tulisan

9. Menambah animasi ukuran / skala, klik pada panah Add, muncul menu Property
- Scale

Anchor Point
Position

Scale
Skew

Rotation
Opacity
All TransFarm Properties

Fill Colar 3

EQ 0:00:02 Skroke Colar h
P s v
”L'fi- _ ﬁiﬂ Tracking

Line Anchor

¢ Qﬁ Parent Line Spacing

Character Offset
Character Yalue

el Property o TS
Gambar 71, Properti,Scale
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10. Maka akan tampil parameter Animatorl - Range Selectorl - Scale. Buatlah 2
keyframe di parameter Scale tersebut
e Aktifkan Time Vary Stop Watch di samping Scale
e Di 00:00f ( detik 0 ), Scale = 800%
e Di07:00f (detik 7)), Scale = 100% ( ukuran normal )

wdon| #| | s |@# % 0BO0w |paet LM
) Source Text

I
[> Path Options |

[ Mare Optians ‘

- = Animstor 1 Add: @ |
= [» Range Seleckor 1 |
< b [%] s postion 100.0,100.0 |

2 = 000, 600.0% \

1) [Z] b Ratation 8% 270.0° i

Gambar 72, Scale

11. Untuk melihat hasilnya klik Play / RAM Preview

| Il |
w
o ( !

Gambar 73, Rotasi dengan Scale
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Animasi Perhuruf dengan Range Selector
1. Sampai sini prinsip animasi teks sudah anda praktekkan, sekarang animasi teks
akan bergerak per huruf dari huruf awal sampai akhir teks “ Puskom Usakti” pada
Timeline, di parameter Range Selector - Start buat keyframe sebagai berikut;
e Aktifkan Time Vary Stop Watch di samping Start
e Di 00:00f (detik 0), Satart = 0% ( teks tidak ada yang dipilih )
e Di07:00f (detik 7), Start = 100% (teks dipilih semua )

Inter-Character Blending (el T¥) |
w7 Animator 1 Add: B

.
L > Range Selector 1
4 = B2

= End 1
© Offet 0%
b Advanced

49 [£] b Postion 00,00 ©
49 (2] e Seale 38 100,0, 100,0% &
40 [2] e Rotation 0x40.0° &

Gambar 74, Range Selector

2. Jalankan Play / RAM Preview, hasil animasi rotasi dan scale pada teks tampil
berurutan dari hurup awal sampai akhir.

PUsKom Y/

Gambar75, Hasil Animasi Range Selector
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Animasi Random / Acak dengan Wiggly
1. Sekarang semua animasi teks ( position, rotation, scale ) akan ditampilkan secara
acak sampai terbaca tulisan “ Puskom Usakti “. Untuk memberikan animasi acak,

klik di panah Add, muncul menu Selector > Wiggly

- Inter-Character Blending (Marmal =]
& =7 Animatar 1 Add: Property b i
- = Range Selector 1
4" b A ot 92 %
-~ End 100 % Expression
o Offset 0o
[+ Advanced

Gambar 76, Selector, Wiggly

2. Maka akan tampil parameter Wiggly Selectorl sebagai berikut

) Offset 0%
b Advanced

Ll b wiggly Selector 1
4<hk [Z] b Postion 16.0,16.0
PR b scale 2120, 2120% © 4
4op B Rotation Dx+43.0¢ h *

= Effects
& I Radal Shadow Reset

b Transform Reset

Gambar 77, Wiggly Selector

3. Hasilnya klik Play / RAM Preview,

Gambar 78, Hasil Animasi Wiggly
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Menambah Animasi Teks terkesan ramai / trail dengan echo
Pada projek sebelumnya anda telah menggunakan Radial Shadow. Untuk menambah
kesan lebih rame / trail / gema, klik menu Effects - Time - echo. Atur parameter
sebagai berikut

e Perhatikan urutan efek di Effect Control adalah Echo terlebih dahulu lalu Radial

Shadow, anda dapat menukar tempat kedua posisi efek tersebut dengan mendrag

ke urutan seperti gambar di bawah

=27 | Echo

[» % Echo Time seconds)
[» ) Mumber OF Echoes 5
[ ) Starting Intensity 1,00

[» 1) Decay 0,30

- %) Echo Operator fgd  [=]

Gambar 79, Animasi dengan Echo
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Jalur / Path untuk Teks “ Pusti ”

1. Teks dibuat dengan Type tool seperti sebelumnya, namun tidak terlalu rumit. Buat

teks dengan warna sesuai selera anda missal seperti gambar dibawabh ini
oject 7 Effect Contraols: PUSTI

[.ﬁ.rial Black. |Tl /‘? 2 i
[Regular |T] 5 Zﬂ

T #8px ¥ fi 10px v
v Metrics v Ay 0 v

= v -
IT 100% v T 100% ¥
&% Opx ¥ _."5.‘_ 0% =

r E TY

Gambar 80, Pusti

2. Gunakan path dengan Pen Tool, agar posisi teks mengikuti path tersebut. Klik Pen
Tool. Pastikan Checklist Rotobezier tidak aktif

B |
©Tools = . . Ciw
R QA D e OMNT & 2
[ W [RrotoBeszier

Workspace: | All Panels [v]

Gambar 81, Pen Tool
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3. Buat garis kurva seperti pada gambar dibawah

Gambar 82, Garis Kurva

4. KIlik panah segitiga pada layer Teks tersebut. Maka akan tampil parameter Text
—> Path Option - Path, pilih Mask1. maka teks akan melengkung mengikuti garis
/ kurva yang kita buat

ﬁi‘ﬂﬂoﬂ! J)!# |SUurceName |-'T-\-'1‘r? ™ 3 O FD ‘Parent
T TTSO TRosT ISR A T T T T 8 None v
= Text Animate: (&)

) Source Text
%7 Path Options
path __________________[joFws
[ Mare Options
[+ Masks
[ Transform

Gambar 83, Mask & Hasilnya

Animasi Scale & Wiggly untuk Teks “ Puskom Usakti”
1. Sekarang tambahkan animasi ukuran / skala, pada parameter Animatorl, klik pada

panah Add, muncul menu Property - Scale

o (i) v

Timelne; Comp 1 %
0:00:05/06  (25.001ps) e

B OA| 4 Source Name | B s N\ QEFC P e
¢ | (100%) v /B 2] Dioos AN Trensform rapsrtes
r A BT i #1 Transform Propstties DN =] o) x|
= Tett Anmzke il Color » imeiine: FIC:' 5
] Sroka Colr
e o, ' D000SI06 @i s SR sewan
[ Path Options Stroke Width =
[\ Mers Optizns @00 | |4 SouceName + 7\ B CAW | Paert e
b Masks Trackeg [ amsm =i TS T TSk  Une incror
U Transform Eesot Line: anchor w Test Anmate: & Lne Spaang
i Lin= Spacing o 2] SourceText
o Charactes Cffset
Character Offset Cheraiter Valie
[l 3% Cheracter yalue P add, o
. e -
i Start| 1 ASUS WF-AP Solo | | hzobe Phozoshop (ot ... | (] sfterstrectss Bl 2 = T

Gambar 84, Animasi Scale & Wiggly
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2. Maka akan tampil parameter Animatorl - Range Selectorl - Position. Buatlah
2 keyframe pada parameter Scale tersebut:
e Aktifkan Time Vary Stop Watch di samping Scale
e Di 00:00f ( detik 0), Position = 150%
e Di 05:00f (detik 5), Position = 100% ( ukuran normal )

57 Text Animate: & |
b [Z] source Text | =]
[ Path Cptions |
[* More Options |
] 7 Animator 1 Add: @ |
] [> Ran |
q & <
[ Masks |
[ Transform FReset |

Gambar 85, Position

3. Klik Play / RAM Preview lihat hasilnya animasi teks dari besar menjadi kecil

Gambar 86, Hasil Animasi

4. Berikan animasi acak, klik di panah Add, muncul menu Selector >Wiggly

Animate:

|
| =
|
|
I

Add: property bi
Selector ¥ Range

139.7,0.0 Expression

Gambar 87, Timeline Wiggly

5. Klik Play / RAM Preview hasilnya animasi teks dari besar akan mengecil secara

acak
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Animasi Card Wipe
1. Efek ini baik untuk membuat transisi ( seperti Linear Wipe & Gradient Wipe )
kelebihanya adalah efeknya mempunyai kesan 3 Dimensi. Aktifkan layer text *
Puskom Usakti “, klik menu Effects - Transition - Card Wipe, atur parameter
seperti gambar dibawah ini

fr
“in

¥ | Card Wipe

Gambar 88, Effect Controls Card Wipe

2. Pada Timeline geser Layer Puskom Usakti, dengan Selection Tool ke 02:00f agar
animasi konak dimualai pada detik ke 2

38 Created by; M.AI' Amin 11/9/2007



3. Untuk membuat animasi, tekan E pada keyboard, maka akan tampil Efek Card
Wipe, di parameter Transition Completion buat 2 keyframe sebagai berikut:
e Aktifkan Time Vary Stop Watch di samping Transition Completion
e Di 02:00f (detik 2 ), Transition Completion = 100 % ( hilang )
e Di07:15f (detik 7 ¥2), Transition Completion = 0% ( teks muncul )

@ 0| & & |SourceName (%N PHOOE |Parent | I
N o
4 B 1ransition Compietion | &
‘) Transkion Width 30 % |
Back Layer (T S— |
) Raws & Columns (Independent [ v/ |
‘) Raws 12 |
') Calumns 22 |
') Card Scale 1.00 |
) Filp fods (Random ___[v) |

Gambar 89, Timeline Effek Card Wipe

4. Klik Play / RAM Preview, hasil animasi seperti gambar dibawah ini

Gambar 90, Preview Effek Card Wipe
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5. Utuk menambah kesan 3 Dimensi dan ketebalan gunakan menu Effects >
Perspective - Bevel Alpha dan Effects - Perspective - Radial Shadow seperti
gambar dibawah ini

=

Gambar 91, Radial Shadow

Menambah Suara atau Musik
1. Lngkah pertama impor dulu file suara atau musik yang anda perlukan, klik menu
File = Import - File mp3, Pada folder PUSTI, Impor File Pintu Surga.mp3 Drag

ke Timeline seperti pada gambar dibawah ini

Gambar 92, Import File Wav
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2. RAM Preview, maka hasil dari animasi anda akan terdengar suara atau musik,
jangan memakai tombol Play karena suaranya tidak akan terdengar.
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